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Abstract: Technology has always been of great help to the disabled and given them a helping hand to allow them to live a normal 

and healthy life like others. we have come up with a novel idea of a glove named Hand talk that will convert hand movements 

into text and allow the deaf to express themselves better. The Hand talk glove needs to be worn on the hand by the deaf or mute 

person and depending on the variation of movement, the device will convert it intelligently into voice for the other person to 

comprehend it easily. The Hand talk glove senses the movements through the flex sensors pads which detect the different patterns 

of motion and the way the finger curls. The device can sense carefully each resistance and each movement made by the hand. 

Currently the device can convert only few words, but depending on the success of this device few more additional words may be 

added later onto this expressive system. The Gestures can be converted to voice by using a Bluetooth Voice App Voice.  

 

IndexTerms—Handtalk,Flex Sensor,Bluetooth,Voice,Android App    

 

I  INTRODUCTION 

Sign language is the language used by deaf and mute people and it is a communication skill that uses gestures instead of sound to 

convey meaning simultaneously combining hand shapes, orientations and movement of the hands, arms or body and facial 

expressions to express fluidly a speaker’s thoughts. Signs are used to communicate words and sentences to audience. A gesture in a 

sign language is a particular movement of the hands with a specific shape made out of them. A sign language usually provides sign 

for whole words. It can also provide sign for letters to perform words that don’t have corresponding sign in that sign language. In 

this project Flex Sensor Plays the major role, Flex sensors are sensors that change in resistance depending on the amount of bend on 

the sensor. This system uses ARDUINO microcontroller to control all the processes and flex sensors along with accelerometer 

sensors will track the movement of fingers as well as entire palm. A flex sensor or bend sensor is a sensor that measures the amount 

of deflection or bending. Usually, the sensor is stuck to the surface, and resistance of sensor element is varied by bending the 

surface. Since the resistance is directly proportional to the amount of bend it is used as goniometer, and often called 

flexible potentiometer. A LCD will be used to display the users gesture and a speaker to translate the gesture into audio signal is 

planned if possible for execution. This system can be further developed to recognize complex like food, water, etc 

 

II  HARDWARE SPECIFICATION 

For the system to be implemented, requirement of following different modules were considered as the individual blocks for 

operation. 

  Input sensors for Hand Gesture Recognition. 

  Signal Conditioning for Data Compatibility to next Stage. 

  Microcontroller for Data Process and Action. 

  Display Device for Data and Menu Display. 

 Bluetooth send the text to another phone. Phone App will take that Voice and play in audio mode. 

 Audio Amplifier for Boosting Audio Level. 

 Speaker for Audio Output 

 

2.1 System Specification 

Table 2.1 Project System Specification 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

S.NO 

 

Type Of Component 

 

Specification 

1. Glove Hand Glove 

2. Microcontroller ARDUINO 

3. Flex Sensors Spectra Symbol 3.5" 

4. LCD HD44780 

5. Bluetooth module HC-05 

6. Signal converter LM358 

7. Speaker 12v 

http://www.jetir.org/
https://en.wikipedia.org/wiki/Sensor
https://en.wikipedia.org/wiki/Deflection_(engineering)
https://en.wikipedia.org/wiki/Bending
https://en.wikipedia.org/wiki/Goniometer
https://en.wikipedia.org/wiki/Potentiometer


© 2019 JETIR  May 2019, Volume 6, Issue 5                                           www.jetir.org  (ISSN-2349-5162) 
 

JETIR1905J06 Journal of Emerging Technologies and Innovative Research (JETIR) www.jetir.org 33 

 

2.2  Block  Diagram 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig 2.1: Block Diagram of Hand Talk using 4 flex sensors 

 

 

2.3  Monitor Section Output From Speakers 

Arduino is the heart of our project. It deals with the input and output functions of the project. Flex sensor response is analogy input 

to the arduino and the analog to digital converter in the arduino converts the input and send as digital input to the 16*2 display and 

bluetooth module. The bluetooth module is connected to the software application on the mobile and it gives as input to the 

speakers. The speaker produces voice output. 

 

2.4  Digital 

In the world of Arduino, Digital signals are used for everything with the exception of Analog Input. Depending on the voltage of 

the Arduino the ON or HIGH of the Digital signal will be equal to the system voltage, while the OFF or LOW signal will always 

equal 0V. This is a fancy way of saying that on a 5V Arduino the HIGH signals will be a little under 5V and on a 3.3V Arduino the 

HIGH signals will be a little under3.3V. To receive or send Digital signals the Arduino uses Digital pins # 0 - # setup your Analog 

In pins to act as Digital pins. 

 

2.5  Analog 

Humans perceive the world in analog. Everything we see and hear is a continuous transmission of information to our senses. The 

temperatures we perceive are never 100% hot or 100% cold, they are constantly changing between our ranges of acceptable 

temperatures. (And if they are out of our range of acceptable temperatures then what are we doing there?) This continuous stream is 

what defines analog data. Digital information, the complementary concept to Analog, estimates analog data using only ones and 

zeros. In the world of Arduino an Analog signal is simply a signal that can be HIGH (on), LOW (off) or anything in between these 

two states. This means an Analog signal has a voltage value that can be anything between 0V and 5V (unless you mess with the 

Analog Reference pin). Analog allows you to send output or receive input about devices that run at percentages as well as on and 

off. The Arduino does this by sampling the voltage signal sent to these pins and comparing it to a voltage reference signal (5V). 

Depending on the voltage of the Analog signal when compared to the Analog Reference signal the Arduino then assigns a 

numerical value to the signal somewhere between 0 (0%) and 1023 (100%). The digital system of the Arduino can then use this 

number in calculations and sketches. To receive Analog Input the Arduino uses Analog pins # 0 - # 5. These pins are designed for 

use with components that output Analog information and can be used for Analog Input. There is no setup necessary, and to read 

them use the command: analogRead(pinNumber); where pin Number is the Analog In pin to which the Analog component is 

connected. The analogRead command will return a number including or between 0 and 1023. The Arduino also has the capability 

to output a digital signal that acts as an Analog signal, this signal is called Pulse Width Modulation (PWM). Digital Pins # 3, # 5, # 

6, # 9, # 10 and #11 have PWM capabilities. To output a PWM signal use the command: analogWrite(pinNumber, value) where pin 

Number is a Digital Pin with PWM capabilities and value is a number between 0 (0%) and 255 (100%). 

 

2.6  LCD(Liquid Crystal Display) 

 

 
 

Fig 2.2 LCD Display 

 

Power 

Supply 

4 Flex 

Sensors 

ADC 

 

Arduino 

UNO  

Bluetooth 

Module 

LCD 

http://www.jetir.org/


© 2019 JETIR  May 2019, Volume 6, Issue 5                                           www.jetir.org  (ISSN-2349-5162) 
 

JETIR1905J06 Journal of Emerging Technologies and Innovative Research (JETIR) www.jetir.org 34 

 

Liquid crystal display a type of display used in digital watches and many portable computers, LCD displays utilize two sheets of 

polarizing material with a liquid crystal solution between them. An electric current passed through the liquid causes the crystals to 

align so that light cannot pass through them. Each crystal, therefore, is like a shutter, either allowing light to pass through or 

blocking the light. The liquid crystals can be manipulated through an applied electric voltage so that light is allowed to pass or is 

blocked. By carefully controlling where and what wavelength (color) of light is allowed to pass, the LCD monitor is able to display 

images. A back light provides LCD monitor’s brightness. Other advances have allowed LCD’s to greatly reduce liquid crystal cell 

response times. Response time is basically the amount of time it takes for a pixel to “change colors”. In reality response time is the 

amount of time it takes a liquid crystal cell to go from being active to inactive here the LCD is used at both the Transmitter as well 

as the receiver side. The input which we give to the microcontroller is displayed on the LCD of the transmitter side and the message 

sent is received at the receiver side which displays at the receiver end of the LCD and the corresponding operation is performed. 

They make complicated equipment easier to operate. LCDs come in many shapes and sizes but the most common is the 16 

character x 4 line display with no back light. It requires only 11 connections – eight bits for data (which can be reduced to four if 

necessary) and three control lines (we have only used two here). It runs off a 5V DC supply and only needs about 1mA of current. 

The display contrast can be varied by changing the voltage into pin 3 of the display. 

 

2.7  FLEX SENSOR 

Input sensor that is flex sensor plays major role. As bending angle increases resistance of flex sensor also increases. This change in 

resistance will be converted into voltage change by connecting flex sensor to potential divider circuit. 

 
Fig 2.3 Flux Sensor 

 

Flex sensors are normally attached to the glove using needle and thread. They require a 5-volt input to operate and it gives output 

between 0 and 5 V. As bending angle of sensor increases resistance of flex sensor also increases. As the sensor varies the output 

voltage changes accordingly. The diagram of flex sensor and its graph is as shown in figure below. The resistance of flex sensor 

will only change in one direction. When sensor is in not working i.e. inflexed at that time its resistance up to 10K and for flexed 

sensor it will increase up to 30k-40k. This change in resistance will be converted in to voltage change by connecting flex sensor 

potential divider circuit. Voltage divider is used to determine the output voltage levels. Voltage across two resistances connected in 

series i.e. .basically resistance to voltage converter. The resistor and flex forms a voltage divider which divides the input voltage by 

a ratio determined by the variable(R1) and fixed resistors(R2) The Flex Sensor is a unique component that changes resistance when 

bent. An un flexed sensor has a nominal resistance of 10,000 ohms (10 K). As the flex sensor is bent the resistance gradually 

increases. When the sensor is bent at 90 degrees its resistance will range between 30-40 K ohms. The flex sensor may be bent 

greater that 360 degrees depending upon the radius of the curve. Its operating temperature is -45F to125F. 

 

III  SOFTWARE IMPLEMENTATION 

The Arduino integrated development environment (IDE) is a cross-platform application (for Windows, macOS, Linux) that is 

written in the programming language Java. It is used to write and upload programs to Arduino compatible boards, but also, with the 

help of 3rd party cores, other vendor development boards. The source code for the IDE is released under the GNU General Public 

License, version 2. The Arduino IDE supports the languages C and C++ using special rules of code structuring. The Arduino IDE 

supplies a software library from the Wiring project, which provides many common input and output procedures. User-written code 

only requires two basic functions, for starting the sketch and the main program loop, that are compiled and linked with a program 

stub main() into an executable cyclic executive program with the GNU toolchain, also included with the IDE distribution. The 

Arduino IDE employs the program avrdude to convert the executable code into a text file in hexadecimal encoding that is loaded 

into the Arduino board by a loader program in the board's firmware.  

 

 3.1 Arduino IDE 

The first time you run the Arduino software, it will automatically create a directory for your sketchbook. You can view or change 

the location of the sketchbook location from with the Preferences dialog. The source code for the IDE is released under the GNU 

General Public License, version 2. The Arduino IDE supports the languages C and C++ using special rules of code structuring. The 

Arduino IDE supplies a software library from the Wiring project, which provides many common input and output procedures. 

 

3.2 Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board and Tools > Port menus. The boards are 

described below. On the Mac, the serial port is probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or 

Leonardo) or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or /dev/tty.USA19QW1b1P1.1 (for a serial board 

connected with a Keyspan USB-to-Serial adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, 

COM5, COM7, or higher (for a USB board) - to find out, you look for USB serial device in the ports section of the Windows 

Device Manager. On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx or similar. Once you've selected the correct serial port and 

board, press the upload button in the toolbar or select the Upload item from the Sketch menu. Current Arduino boards will reset 

automatically and begin the upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the reset button on 

http://www.jetir.org/
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the board just before starting the upload. On most boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. The 

Arduino Software (IDE) will display a message when the upload is complete, or show an error. 

 

3.3  Serial Monitor 

This displays serial sent from the Arduino or Genuino board over USB or serial connector, as shown in Fig.4.2. To send data to the 

board, enter text and click on the "send" button or press enter. Choose the baud rate from the drop-down menu that matches the rate 

passed to Serial.begin in your sketch. Note that on Windows, Mac or Linux the board will reset (it will rerun your sketch) when you 

connect with the serial monitor. 

 

IV   RESULTS 

By debugging the code and uploading the code then on LCD it will print our project title on the basis of the code Here it is 

displaying system for deaf and dumb people after the above message displayed and it will display with in nanoseconds When a 

flex sensor bends it will display the respective message according to the code here it is displaying coffee on lcd display.  

Whatever displayed on lcd that message will come out from phone speakers through Bluetooth voice app. 

 

 

   

 

 

 

Fig 2.4 : System working with Flex Sensor  

 

 

 
 

Fig 2.5 : System working with Flex Sensor  
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Fig 2.6 : System working with Flex Sensor  

 

 

V  CONCLUSION 

This paper describes the design and working of a system which is useful for deaf and dumb people to communicate with one 

another and with the normal people. The deaf and dumb people use their standard sign language which is not easily 

understandable by common people. This system converts the sign language into voice which is easily understandable by the 

people. The sign language is translated into text form, to facilitate the deaf people to convey their messages as well to the others. 

This text is display on LCD and also through speaker by which the other person can understand. In this way our project is very 

well useful for deaf and dumb people and for other robotics applications etc. The completion of this prototype suggests that sensor 

gloves can be used for partial sign language recognition. More sensors can be employed to recognize full sign language. A handy 

and portable hardware device with built-in translating system, speakers and group of body sensors along with the pair of data 

gloves can be manufactured so that a deaf and dumb person can communicate to any normal person anywhere. To reduce the size 

of unit we can use SMD. High quality sensor can use. The range can be increased. 

 

Applications 

Data gloves can only capture the shape of the hand  and  not  the  shape  or motion of other parts of the body  e.g. arm,  elbows,  

face  etc.  So only postures are  taken and moving gestures are ignored. 

 Physically challenged persons 

 Communication between the mute peoples and the normal peoples 

 Conveying information related operations 

 Medical application 

 In public place for announcement 
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